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1. Introduction

To support the National Archives and Records Administration (NARA) in its effort to establish a
secure distributed processing of electronic records archives (ERA), the U.S. Army Research
Laboratory (ARL) developed an experimental information-assurance product, ARL Secure Link
middleware?, which is capable of providing data confidentiality between two networked
computers. ARL has also developed a convenient method for running the middleware using a set
of graphical user interfaces (GUIs).

This report documents the results of the development of the GUI, describes its features, and
reveals its internal operations. The intended readers of this report include technical and
managerial personnel as well as anyone who is interested in using the ARL Secure Link
middleware or finding out how the GUI was built.

Section 2 describes the internal implementation of the GUI and the methods for running the ARL
Secure Link middleware. Section 3 includes the screen shots of the GUI and describes the
functionality of the interfaces. Section 4 discusses the development of the tool. Section 5
concludes the report.

2. Methods

The GUI developed for running the ARL Secure Link middleware was created using the Python
programming language?, its standard Tkinter module, and the Popen class of the subprocess
module. The Popen class facilitates the interaction between the GUI and its execution
environment by providing a means to control the operation of the middleware and its associated
firewall. The paragraphs that follow describe the use of the Popen class in the GUL.

» Starting and stopping the ARL Secure Link middleware. The middleware was designed to
run in the background as a daemon; hence it was named sld to stand for Secure Link
daemon. A daemon is a computer program running in the background and requires no user
interactions. Upon a successful execution of the sld, its running process identification
(pid) is captured and saved for subsequent uses such as sending a signal to the running
process:

pid = Popen(sld).pid

1 Luu, Brian. Functional Requirements Assessment of Secure Link, ARL-MR-663; U.S. Army Research Laboratory:,
Adelphi, MD, March 2007.

2 The Python Software Foundation, http://www.Python.org (accessed 15 Oct 07).




To stop a running sld, the GUI can send the kill —s SIGKILL pid or the killall sld
command. The latter is the more preferable method for gracefully stopping all active sld
processes because the killall command sends the SIGTERM signal (by default) that can be
caught by the running processes. Upon receiving the SIGTERM signal, each sld process
would clean up its work before terminating. Whereas, using the SIGKILL signal
terminates sld processes abruptly, giving them no chance to close an opened file or a
network communication socket, and thus leaving behind the system at an undetermined
state.

» Enabling and disabling the firewall. The iptables command is used as the firewall with
which the ARL Secure Link middleware operates. The command is often executed with
specific instructions and options. To monitor the internal tables of the command (the state
of the firewall), the GUI connects and redirects its outputs, including error messages, to an
internal storage, s, by executing the following two statements:

Statement 1. p = Popen(<iptables-command>, shell=True, stdout=PIPE,

stderr=STDOUT,close_fds=True).stdout

Statement 2. s =p.read()

Statement 1 executes a specific iptables command, and statement 2 retrieves the outputs of the
executed command. The outputs are immediately displayed in the GUI.



3. Graphical User Interfaces

The GUI of the ARL Secure Link middleware was built using the standard widgets readily
available in the Tkinter library, which is a Python extension to the tcl programming language
and the tk GUI toolkit.® When the GUI is executed, it appears on the computer screen as shown
in figure 1.

e The ARL SecureLink Middleware
File Test Help
Start ||sld <cert= <key> <CA cert>
Protect | 192.166.1.6 192.166.1.254
Unprotect | 192.166.1.6 192.166.1.254
Enable | Reset |
Y
—II

b ey

Figure 1. The initial appearance of the GUI of the ARL Secure Link middleware.

3 Tl Developer Xchange, http://www.tcl.tk (accessed 15 Oct 2007).



Important widgets that were used to build the GUI include the Frame, Menubar, Button, Entry,
Text, Scrollbar, and Label widgets. The Frame widget contains other widgets, including other
Frame widgets. Figure 2 shows the Tkinter widgets that were used to build the GUL.

BNl @ TheARL SecureLinkMiddleware | SGE
File Test Help @
@ Start sld <cett= <key><C4 cer= /,,.-.,\
{ ﬁ_ \ Protect 192.168.1.6 192.168.1.254 [Entry)
l 5" J Unprotect |192.155.1.5 192.168.1.254
\:y Enable Reset

AL

TeqTToaos

.,

(:Labelj |

.,

Figure 2. Tkinter widgets.



On the top of the GUI is the Menubar with three pull-down menus containing features
infrequently used during the operation of the ARL Secure Link middleware. However, the user
has an option to “tear off” the menus to make them permanently displayed until they are
manually destroyed. The torn-off menus are depicted in figure 3.

File Test Help
|

(MEE) (VIEER) (YEEX)
Config... TestExec Usage
3ave TestFipe Syntax
Exit Version

b - Ahout

Figure 3. The pull-down menus.

The three pull-down menus include two menus for the users (File and Help) and one menu for
the developer (Test). The File menu has three menu items: Config..., Save, and Exit.
Selecting the Exit menu item shuts down the operation of the ARL Secure Link middleware,
resets the state of the firewall, closes the log file, and destroys the GUI. Selecting the Save
menu item stores the currently configured options to a file whose name is a configuration
parameter. Selecting the Config... menu item displays a table of configuration parameters and
their current values as shown in figure 4. A new value can be entered in the Entry box of the
parameter. Pressing the OK button confirms the change. Pressing the Cancel button closes the
window and abandons the change.

(=)= =] _______________ Config..The ARL SecureLink Middleware

Config... # | Path to the "iptables” Firewall: |fusrflacalfshinfiptables

Save Path to the "killall" Command: ‘ust/bindkillall

(=5 Path to the ARL Securelink CA Ceriificate: |f|0calfcer‘[iﬂcatesfcerthpfera—ca—pr.crt
Path to the ARL Securelink Certificate: focalicertificates/cerdpZpipeert-pep.cr
Path to the ARL Securelink Configuration Fle: |a’etc.n’s|d.cunf
Path to the ARL Securelink Key: Jocalicerificates/cerdpZpipeert-pep.kay
Path to the ARL Securelink Log File: |sld.|c|g
Path to the ARL SecureLink Middlewsare: fustilocal’shingsld

ok | Cancel

Figure 4. Configuration parameters.



The Test pull-down menu is used during the development of the GUI to experiment with new
features. Selecting any item of the Test menu does not affect the operation of the ARL Secure
Link middleware.

The Help pull-down menu has four different informational types: Usage, Syntax, Version, and
About as shown in figure 5. Selecting the Usage menu item gives a short set of instructions on
how to run the ARL Secure Link middleware using the GUI. Selecting the Syntax menu item
displays the ordered list of required parameters for running the middleware. Selecting the
Version menu item shows the version and the date of the GUI. Selecting the About menu item
shows a blurb about the tool.

v

@ The ARL Secure Link riddleware is
designed and implemented by B, Luu
of the U.8. Army Research Laborator to
provide an assurance of
confidentiality between a pair of

@ Usage: /SecLnk py [cont=/sld.conf]

Before running any cormmand, view the
configuration parameters and change

them if : =
. Thos g communicating entities. However,
rclﬁé:lfscags'eselea Il O \ before this service can be rendered, the

two entities must mutually

werify their claimed identities, Doing so
necessitates the use of

peer-to-peer cryptographic certificates,
ARL creates and installs the

- To start/stop the ARL Secure Link
middleware, click the Start/Stop button.
- To enable/disable the firewall, click the

Enable/Tisable button . certificates in every networked
- To protect one or more hosts, enter comnputer that uses the ARL SecureLink
their IP addresses and press the Protect middlewrare.

- To unprotect one or more hosts, enter

their IP addresses and press the

Unprotect button.

- To Exit, select File-->Exit or
click the 2 butten located enthe

upperright corner of the screen

B. Nguyen of ARL is the author of an
in-house certification autherity (CA)
that issues and signs the needed
certificates using the OpenSEL
command.

He also creates the graphical user
interface for the ARL SecureLink
middlewrare

and provides a convenient method for
confrolling and managing the
middlewrare

and its associated firewall

MNote that using the ARL SecureLink
middleware outside ARL will require
authorization from the ARL Technology
Transfer office.

POC:

The ARL Secure Link middleware :
blun@arl. army.mil

The GUI and mutual authentication:
bnguyeni@arl. army.mil

The ARL Technology Transfer office:
mrausaf@ arl, army.mil

@ The ARL SecureLink Middleware,
Wersion 0.1, September 2007
Brian Luu and Binh Nguyen
{bluulbnguyen k@ arl. army.mil

o |

Figure 5. The Help menu and its contents.

Below the pull-down menus, the GUI is divided into three sections. The first section provides
the user a way to interact with the ARL Secure Link middleware. It has five action buttons and
their related Entry boxes. The buttons are labeled Start/Stop, Protect, Unprotect,
Enable/Disable, and Reset. Pressing the Reset button terminates the running ARL Secure
Link middleware, clears the internal tables of the firewall, and erases the display area of the GUI.
Pressing the Enable button initializes the state of the firewall and changes its label from Enable
to Disable. Pressing the Disable button resets the firewall and changes its label back to Enable.



The Unprotect button requires a list of one or more internet protocol (IP) addresses to be entered
and displayed in its corresponding Entry box, located on the right side of the button. Pressing
the Unprotect button or pressing the Enter key while the mouse cursor is in the Entry box
instructs the ARL Secure Link middleware to stop providing confidentiality services to the
host(s) having their addresses displayed in the Entry box. Similarly, the Protect button is used
to instruct the middleware to provide confidentiality services to the host(s) having their addresses
displayed in the corresponding Entry box. The lists of unprotected and protected hosts need not
be identical. In order for the two buttons to function properly, the sid daemon must be running
and the firewall must be enabled.

The Start button is used to run the sld daemon with its predetermined configuration parameters
or running it with a different set of cryptographic certificates shown in its corresponding Entry
box. Once the sld daemon has been executed, the button changes its label from Start to Stop
and then enables the firewall as if the Enable button were pressed by the user as shown in
figure 6.

R The ARL SecurelLink Middleware =~~~
File Test Help
Stop ||sld <cert= <key> <Ca cert>

Protect | 192.166.1.6 192.168.1.254

Unprotect | 192.166.1.6 192.168.1.254

Disable | Reset
fscflocalfshbinfiptables -A OUTPUT -f mangle -p top --sport 3838 -j ACGCEPT -j:
fscflocalfshinfiptables -A OUTPUT -t mangle -p top --dport 3838 -7 ACCEPT
fascflocalfshindfiptables -t mangle -nlL
Chain PREROUTING (policy ACCEERT)
target prot opt source destination
Chain INPUT (policy AGCEPT)
target prot opt source destination
Chain FORWARD {(policy ACCEPT)
target prot opt source destination
Chain OUTPUT (policy ACCEERT)
target prot opt source destination
BCCEET udp -- 0.0.0.0/0 0.0.0.0/0 udp dpt:3838
&CCERT tep -- 0.0.0.0/0 0.0.0.0/0 tcp spt:3838
&CCEET tep -- 0.0.0.0/0 0.0.0.0/0 tcp dpt:3838
Chain POSTROUTING {(policy ACCEPT)
target prot opt source destination

/

R ey

Figure 6. The appearance of the GUI during operation.



The second section of the GUI is the largest area that uses the Text and Scrollbar widgets to
display the executed commands and their outputs, which provides the user a way to visually
monitor the status of the firewall immediately after every execution of a command. In addition
to displaying the history and outputs of the executed commands, the GUI also writes to a log file
the date and time of an executed command and its outputs. Pressing the Reset button clears the
display area, but does not clear the log file. The contents of the log file are subsequently used for
post-analysis of user-initiated events and the status of the firewall to support the development
and improvement of the ARL Secure Link middleware. If a log file is unwanted, then the name
/dev/null must be set as its name. The GUI will continue sending logged messages to /dev/null,
but the user will not be able to see and keep them.

The third section is a thin strip located at the bottom of the GUI used to provide user-feedback
messages. It is often known as the status bar.

The operation of the GUI consists of two sequential steps: (1) initialization, and (2) waiting for a
user-initiated event. During the initialization phrase, the GUI checks for the existence of the
given configuration file, which has specifications of paths to the vital files that ARL Secure Link
middleware needs to function. (Appendix A provides an example of the configuration file.) If
the given configuration file exists and is readable, then the GUI reads in its contents to parse and
extract the configured parameter values. If the configuration file does not exist, the GUI uses its
default values that can be subsequently changed by the user. The GUI then verifies the existence
of the configured values by checking the specified paths to the files and creating a list of invalid
paths. At the end of the verification, if the list is non-empty, the GUI opens a dialog window
showing the invalid paths and asking the user to decide whether the GUI should exit or continue
running. Figure 7 depicts the dialog showing the name of the configuration file that does not
exist during the initialization phase. Pressing the No button terminates the GUI. Pressing the
Yes button lets the GUI continue running (mainly for exploration and learning purposes).

@ sld.conf

Lo yvou want to continue?

Yes Mo l

b o
Figure 7. The dialog showing missing files.




Throughout the session, the GUI simply waits for the user to select one of its built-in features.
Each selected feature creates an event that drives the GUI into action. The following events are
suggested for running the GUI-equipped ARL Secure Link middleware.

Verify that all values of the configuration parameters are correct by selecting the pull-down
menu item File:Config....

Start the ARL Secure Link middleware and enable its associated firewall by pressing the
Start button.

Provide confidentiality services to a set of hosts by entering their IP addresses into the
Entry box of the Protect button and pressing the Enter key or Protect button.

Deprive one or more hosts of confidentiality services by entering their IP addresses into the
Entry box of the Unprotect button and pressing the Enter key or Unprotect button.

Terminate the ARL Secure Link middleware without leaving the GUI by pressing the Stop
or Reset button.

4. Results and Discussion

Using the GUI to run the ARL Secure Link middleware was simple. Learning how to use it
could be completed in about 5 minutes. The GUI simplifies the learning, training, and operating
purposes. All the configuration parameters are readily available to its users to view and to
change, if necessary. All the locations of the vital files needed for a successful session were
clearly specified and presented to the user. The whole process of creating a secure
communications among the participating networked computers consists of three major steps: (1)
running the middleware, (2) deciding the hosts that will receive the confidentiality services and
the hosts that will not, and (3) terminating the middleware and reset the system.

The GUI was successfully built and run on Linux environments where the ARL Secure Link
middleware and the iptables packet-filtering system operate. Besides providing convenient
methods for running the two system tools, the GUI offers a way to edit and manage important
configuration parameters. It also automatically counts and records user-initiated commands,
captures the outputs of the executed commands, and creates a log file storing historical events in
a session (Appendix B) for subsequent analysis, debugging, training, or reporting purposes.

The use of the Python programming language enables the GUI to run in any operating system
that hosts a current Python interpreter. In fact, ARL developed the GUI in a Microsoft
Windows environment, but tested it in a Linux environment where the ARL Secure Link
operates. Appendix C shows the appearance of the GUI in a Microsoft Windows environment.



The use of the Python programming language and its Tkinter modules saves resources that
would have been spent to develop a separate GUI for each operating system.

Had a version of the ARL Secure Link middleware been developed to run in a Microsoft
Windows environment, then the GUI would have been ready to interact with the middleware,
requiring no changes to the core structural components of the GUI and a few changes to the
system interfaces to accommodate the idiosyncrasy between the two different operating systems.

5. Conclusions

The GUI and the methods for running the ARL Secure Link middleware represent a convenient
way for dealing with system and application software. The use of the Python programming
language really expedites the development process, thereby increasing programming
productivities and shortening development time. Its standard built-in GUI modules were easy to
integrate into a complete system, thereby voiding the need of a GUI development tool. This
source code of the GUI can serve as a template for designing the GUI for other applications.
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Appendix A. The Contents of the Configuration File

#This file is automatically generated by the
#GUI of the ARL Secure Link Middleware
#

#@Path to the ARL SecureLink Configuration File:=sld.conf

#@Path to the ARL SecureLink Log File:=sld.log

#@Path to the ARL SecureLink Key:=/local/pki/certp2p/peerl-p2p.key

#@Path to the "killall" Command:=/usr/bin/killall

#@Path to the "iptables" Firewall:=/usr/local/shin/iptables

#@Path to the ARL SecureLink Middleware:=/usr/local/sbin/sld

#@Path to the ARL SecureLink CA Certificate:=/local/pki/certp2p/era-ca-p2p.crt
#@Path to the ARL SecureLink Certificate:=/local/pki/certp2p/peerl-p2p.crt
#@Protected IP addresses:=192.168.1.6 192.168.1.254

#===== requested variables:

syskey="/local/pki/certp2p/peerl-p2p.key"
syscacert="/local/pki/certp2p/era-ca-p2p.crt"
syscert="/local/pki/certp2p/peerl-p2p.crt"
protect="192.168.1.6 192.168.1.254"

#Mon Oct 15 10:52:30 2007

11



INTENTIONALLY LEFT BLANK.
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Appendix B. An Example of the Log File

Wed Oct 17 11:09:15 2007: 1 /usr/local/sbin/sld /local/pki/certp2p/peerl-p2p.crt /local/pki/certp2p/peerl-p2p.key
/local/pki/certp2p/era-ca-p2p.crt

Wed Oct 17 11:09:15 2007: 2 /ust/local/sbin/iptables -A OUTPUT -t mangle -p udp --dport 3838 -j ACCEPT
Wed Oct 17 11:09:15 2007: 3 /usr/local/sbin/iptables -A OUTPUT -t mangle -p tcp --sport 3838 -j ACCEPT

Wed Oct 17 11:09:15 2007: 4 /usr/local/shin/iptables -A OUTPUT -t mangle -p tcp --dport 3838 -j ACCEPT

Wed Oct 17 11:09:15 2007: 5 /usr/local/sbin/iptables -t mangle -nL

Chain PREROUTING (policy ACCEPT)

target prot opt source destination

Chain INPUT (policy ACCEPT)

target  prot opt source destination

Chain FORWARD (policy ACCEPT)

target  prot opt source destination

Chain OUTPUT (policy ACCEPT)

target  prot opt source destination

ACCEPT udp -- 0.0.0.0/0 0.0.0.0/0 udp dpt:3838
ACCEPT tcp -- 0.0.0.0/0 0.0.0.0/0 tcp spt:3838
ACCEPT tcp -- 0.0.0.0/0 0.0.0.0/0 tcp dpt:3838

Chain POSTROUTING (policy ACCEPT)

target prot opt source destination
ROUTE 0 -- 0.0.0.0/0 192.168.1.6 ROUTE oif:sld
ROUTE 0 -- 0.0.0.0/0 192.168.1.254 ROUTE oif:sld

Chain POSTROUTING (policy ACCEPT)

target  prot opt source destination

Wed Oct 17 11:09:51 2007: 21 /usr/bin/killall sld

Wed Oct 17 11:09:51 2007: 22 /usr/local/sbin/iptables -D OUTPUT -t mangle -p udp --dport 3838 -j ACCEPT
Wed Oct 17 11:09:51 2007: 23 /ust/local/sbin/iptables -D OUTPUT -t mangle -p tcp --sport 3838 -j ACCEPT
Wed Oct 17 11:09:51 2007: 24 /usr/local/sbin/iptables -D OUTPUT -t mangle -p tcp --dport 3838 -j ACCEPT
Wed Oct 17 11:09:51 2007: 25 /usr/local/sbin/iptables -t mangle -nL

Chain PREROUTING (policy ACCEPT)

13



target  prot opt source destination

Chain INPUT (policy ACCEPT)

target  prot opt source destination

Chain FORWARD (policy ACCEPT)

target  prot opt source destination

Chain OUTPUT (policy ACCEPT)

target  prot opt source destination

Chain POSTROUTING (policy ACCEPT)

target  prot opt source destination

Wed Oct 17 11:10:03 2007: 40 /usr/bin/killall sld

14



Appendix C. The Appearance of the GUI in Microsoft Windows
Environments

The ARL SecureLink Middleware B The ARL SecureLink Middleware ! AEJZI

File Test Help Fie Test Help
Start sld ccerts ckeyr <CA certy Stop sld <certy <keyr <CA certy
Protect 192.168.1.6 192.168.1.254 Protect 192.168.1.6 192.168.1.254
Unprotect 192.168.1.6 192.168.1.254 Unprotect 192.168.1.6 192.168.1.254
Enable Reset Disable Reset |
[Errar 3] The system cannot find the path specified ;j
o8-l =loi e o et T e
TestExec close_[ds is not supported on Windows platfoims
SM TestPipe close_[ds is not supported on Windows platforms

- ew... 3
Do . =
\lf) sld <cert> <key> <CA cert> Ailcare
Synkax flocalipkijcertpzpipeer1-p2p.key
“ Jusr bin/klall
b : i ust localjzbinfiptables
About Jusr/flocalfsbin/sd
About - The ARL Securelink Middleware N X nﬁaw%ﬁ;’ﬁpﬁm
- Do you want to continue?
\:!) The ARL Secure Link middleware is designed and implemented by B. Luu
of the U.5. Army Research Laborator to provide an assurance of
confidentiality between a pair of communicating entities, However, Mo I
before this service can be rendered, the bwo entities must mutualky

wverify their claimed identities. Dwnsormsstmﬂn of
peer-to-peer aryptographic certificates. ARL creates and installs the =
cerlﬂcatusnevewnetmdcnmube:matmestmmﬁmetrk

B. Nguyen of ARL is the author of an in-house certification autharity (CA)
that issues and signs the needed certificates using the OpenSsL c :
He also creates the graphical user nterface for the ARL Securelink middisware \!') Usage: M:\MyPythonProgstarl-weliSecLokiSecLnk.py [conf=./sid.conf]

and provides a convenient method For controlling and managing the middleware

and its associated Firewall, Before running any command, mthecwﬂquebonpamtersarddtmﬂw‘nf
necesary: Select File-->Configure. .., click Close.

Note that using the ARL Securelink middleware outside ARL will require

authorization from the ARL Technology Transfer office, - To startfstop the ARL Secure Link middleware, click the StartfStop button,
- To enable/disable the firewall, dlick the Enable/Disable button

POC: -Tapmteﬂoneornmhnsts,s'\tarth&lpadd‘nsmsmdprasslhaw:\te:tbmmn

The ARL Secure Link middleware blul.l@a'lamymi - To unprotect one or more hosts, enter their IP addresses and press the Unprotect button,

The GUI and mutual authentication : bnguyen@arl.army . mil - To save the current configuration parameters, select File-->Save

The ARL Technology Transfer Dfﬁua mwsa@alamymi - To exit, select File-->Exit or

click the % button located on the upperright corner of the screen,
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U.S. Army Research Laboratory
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graphical user interfaces

internet protocol

National Archives and Records Administration

process identification
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ARMAMENT RSRCH DEV AND ENGRG
CTR

ARMAMENT ENGRG AND TECHNLGY
CTR

ATTN AMSRD AAR AEF T J MATTS
BLDG 305

APG MD 21005-5001

US ARMY TRADOC

BATTLE LAB INTEGRATION & TECHL
DIRCTRT

ATTN ATCD B

10 WHISTLER LANE

FT MONROE VA 23651-5850

PM TIMS, PROFILER (MMS-P)
AN/TMQ 52

ATTN B GRIFFIES

BUILDING 563

FT MONMOUTH NJ 07703

SMC/GPA
2420 VELA WAY STE 1866
EL SEGUNDO CA 90245-4659

US ARMY INFO SYS ENGRG CMND
ATTN AMSEL IE TD F JENIA
FT HUACHUCA AZ 85613-5300
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US ARMY RDECOM
ATTN AMSRD AMR W C MCCORKLE

REDSTONE ARSENAL AL 35898-5000

US GOVERNMENT PRINT OFF
DEPOSITORY RECEIVING SECTION
ATTN MAIL STOP IDAD J TATE

732 NORTH CAPITOL ST NW
WASHINGTON DC 20402

US ARMY RSRCH LAB
ATTN AMSRD ARL RO EV

RESEARCH TRIANGLE PARK NC 27709

US ARMY RSRCH LAB
ATTN IMNE ALC IMS MAIL &

ATTN AMSRD ARL D JM MILLER
ATTN AMSRD ARL CI OK TL TECHL

ATTN AMSRD ARL CI OK T TECHL
ATTN AMSRD ARL CI G RACINE

ATTN AMSRD ARL CI CN
B RIVERA (1 COPY)
ATTN AMSRD ARL CI CN
R GOPAUL (1 COPY)
ATTN AMSRD ARL CI CN

ATTN AMSRD ARL CI CN
B NGUYEN (2 COPIES)
2800 POWDER MILL ROAD
ADELPHI MD 20783-1197

No. of
Copies Organization
1HC COMMANDER
5400 FOWLER RD
1HC
1HC DIRECTOR
W D BACH
PO BOX 12211
12 HCs
RECORDS MGMT
LIB (1 COPY)
PUB (2 COPIES)
(2 COPIES)
B LUU (2 COPIES)
1HC

US ARMY RESEARCH LAB
AMSRD CI OK TP TECHL LIB
ATTN T LANDFRIED

APG MD 21005



No. of
Copies Organization

5HCs ROBERT CHADDUCK

1Elec US NATIONAL ARCHIVES & RECORDS
ADMIN
8601 ADELPHI RD
COLLEGE PAR MARYLAND 20740-6001

Total: 30 (2 Electronic, 28 HCs)
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